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Chapter 1- Getting Started 

1.1 Overview of PostView 
PostView is a finite element (FE) post-processing application that is designed to view 
FEBio output files. It offers several post-processing capabilities, such as generation of 
surface plots, isosurface plots, plane cuts, and many more. A short list of features 
supported in the current version: 
 

• Graphical User Interface (GUI) 
• Command Line Interface 
• Command Line Calculator 
• 3D visualization of model and data 
• Diverse plotting modes for visualization 
• Customizable Graphics View 

 
The GUI of PostView allows the user to interact with the FE model in an easy and 
intuitive manner. For the more advanced user PostView also offers a command line 
alternative. 
 
In addition to reading FEBio output files, PostView can read several file other file 
formats, including LSDYNA keyword and database files, NIKE3D input and output files 
and FEBio input files.  It also allows the user to import user defined data, offering a 
flexible tool to accommodate the analysis of results from other FE softoware programs in 
PostView.  Other file formats are often added based on the needs of our user community, 
so if a format that you need is not yet supported, please contact us through the PostView 
forums to log a feature request (http://mrl.sci.utah.edu/forums/).  Additional file formats 
for import can usually be added within a few days. 
 

1.2 Running PostView 

1.2.1 System Recommendations 
PostView runs on Windows XP, Linux and MAC OSX. In order to run PostView, a 
memory size of at least 512 Mb is recommended. Larger models may require more 
memory. A processor speed of at least 1 GHz is also recommended. The computer’s 
graphics card must support OpenGL, since the application makes extensive use of this 3D 
graphics library. 
 

1.2.2 Command Line Options 
When starting PostView from the command line under Unix, Linus, or Mac OS/X, the 
full syntax for the command is: 
 
>postview [filename] 
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Here, filename is the optional name of an FEBio plot file. If a filename is specified, the 
file will be loaded into the PostView environment when PostView executes. 
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Chapter 2- Tutorial 
This chapter describes some of the main features of PostView by using a sample FEBio 
output file that comes with the PostView distribution. The sample is called “sample.plt” 
and shows a cylinder contacting a deformable box. 
 
In this tutorial you will learn: 

• to open an existing FEBio output file 
• position the model in the graphical view 
• change a few viewing options 
• saving a screenshot of the display 

 

2.1 STEP 1: Opening the sample plot file 
To open the sample plot file, select the File/Open menu. A standard file dialog box 
appears. Select the file sample.plt from the PostView installation folder and click OK. 
This should load the sample data into PostView. After loading, the display should look 
similar to Figure 1. 
 

 
Figure 1. Screenshot of the sample plot file. 

 
You can see the model in the Graphics View (GV). By default, the color display by 
default does not show any data values, but rather assigns unique colors to each material. 
In the upper-left corner, below the title of the plot file, you can see what is being 
displayed.  When an expression field is selected, the name of the expression will appear 
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here.  A vertical colored bar showing the legend will also appear on the right of the 
graphics view. 
 

2.2 STEP 2: Setting some options that affect the display 
Moving to the last timestep. In this step we will change a few settings so we can display 
what we really want. The first thing we’ll do is go to the last timestep. This is done by 
selecting the far right button (>>) on the time controller, located in the lower left of the 
window. This will advance the solution to the last timestep. You can also push the next 
timestep button (>|) to advance one step at a time until you reach the final timestep. Still 
another way is, when positioned on the very first step, to push the previous timestep (|<) 
button which will loop the solution to the last step.  To continuously loop through each 
timestep, the play (>) button can be pushed.  
 
Positioning the model. You can rotate the current view of the model by holding down 
the left mouse button while dragging the cursor over the Graphics View. By 
click+dragging the right mouse button, you can also zoom in or out. To move the model 
left, right, up or down simply click+drag the middle mouse button. 
 
Changing the surface expression. By default, when loading a data file, PostView will 
not display any value on the surface. To change this, open the post options dialog by 
selecting the Post/Options menu. You should see the Options dialog box, such as 
displayed in figure 2. 
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Figure 2. The Post-options dialog box. 

 
To change the expression for the surface, select the drop-down box named Expression. 
Now select Effective Strain, found in the Strain submenu. After selecting OK, the 
graphics view will be updated in accordance with the new settings. Alternatively, you can 
also select the expression from the toolbar, located below the main menu.  
 

2.3 STEP 3: Saving a screenshot 
In this step we will save the current graphics view to an image file. First, we need to 
select the part of the screen we wish to save. Display the safe frame by selecting the 
View/Toggle Safe Frame from the menu. The safe frame surrounds the area of the screen 
that will be stored. You can move it around by selecting and moving its borders. To 
resize it, select and drag the triangular area in the lower right corner. For precise 
positioning, select the Edit/Properties from the menu, or double-click on the frame. A 
dialog box will appear that allows you to enter the position and dimensions manually. 
With the safe frame in place, we can now go ahead and save the view. This can be done 
by either selecting of File/Snapshot from the menu (or pressing its shortcut ctrl+p) or by 
pressing the Snapshot toolbar button. A standard file dialog box now appears that allows 
you to select a file type and enter a filename. 
 
This completes our tutorial. The points to remember are: 

• Use File/Open to open an existing plot file 
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• You can use the mouse to position the model by left or right-click-dragging 
• The Post/Options menu shows a dialog box where you can change the viewing 

options 
• The File/Snapshot menu you can use to save the current graphical view to an 

image file 
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Chapter 3- The PostView Environment 

3.1 The GUI 
PostView has a Graphical User Interface (GUI) that offers an easy and intuitive way to 
interact with the FE model. Figure 3 shows the GUI when the program starts and after the 
sample file is loaded. 
 

 
Figure 3. The GUI after the sample file has been loaded 

Menu Bar 
Toolbar 

Time Control Command bar 

Graphics View 

Command line 

 
The GUI consists of several items. The Menu Bar at the top allows access to the various 
PostView options and settings. Located below the menu bar is the Tool Bar. The 
Graphics View (GV) shows a 3D view of the FE model. At the bottom left, the Time 
Controller is used to select the timestep that is being displayed. To the right of the Time 
Controller is the Command Bar, which offers a quick way to access commonly used 
commands. The Command Line can be found in the lower right part of the screen and can 
be used as an alternative to invoke PostView commands.  

3.2 The Menu 
In this section we will give an overview of the different menu items that can be found in 
PostView. The main menu bar, located at the top of the window, consists of the following 
items: 

• File – file operations, such as opening and saving data. 
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• Edit – options that apply to the current selection, such as hiding, un-hiding, etc. 
• Post – do some post-process operations and set the post-processing options 
• Animate – record an animation of the current Graphics View 
• View  – provides options to customize the Graphics View 
• Help – allows access to PostView help and the About dialog box 

 
A more in-depth description of the different menu items follows. 

3.2.1 The File Menu 
The file menu gives access to file operations and has the following menu items: 

• Open – Opens a plot file 
• Save – Saves the data to file 
• Update – Reload the last loaded data file 
• Export – Export the current model to file 
• Model Info – Displays information about the currently loaded model 
• Snapshot – Take a snapshot of the current GV 
• Exit - Quits the application 

 

3.2.2 The Edit Menu 
The edit menu gives access to operations that apply on the current selection: 

• Hide Selected - hides the current selected elements 
• Hide Unselected - hides the non-selected elements 
• Invert Selection - inverts the current selection 
• Unhide All - Un-hides all the previously hidden elements 
• Select All - selects all visible elements (invisible elements remain unselected) 
• Clear Selection - Clears the current selection 
• Delete – deletes the currently selected object from the GV 
• Properties – modify the properties of the currently selected GV object 

 

3.2.3 The Post Menu 
The post menu allows the user to set many of the options that effect what is being 
displayed. 

• Options - Set many of the options that effect what is being displayed 
• Summary - Provides some 2D plots of several fields such as displacement, strain, 

stress, etc. 
• Plane Cut - Displays a plane cut view of the model. 
• Statistics – Displays a bar chart of the currently displayed data 
• Trackview - Shows a time history of selected nodes or elements 
• Material Manager - Displays the Material Manager 
• State Manager – shows an overview of the states of the model 
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3.2.4 The Animate Menu 
The Animate menu gives the user access to the recording capabilities of PostView. 
 

• New – Select a new target file for the animation 
• Start recording – start recording the GV and store the frames to a file 
• Pause recording – pause the current recording 
• Stop recording – stop the current recording and close the target file. 

3.2.5 The View Menu 
The view menu allows the user to choose options that customize the display. 

• Settings - Set foreground and background colors and style 
• Toggle Safe Frame – displays or hides the safe frame.  

3.2.6 The Help Menu 
The help menu allows access to the help features available in PostView and access to the 
software version and developers information. 

• PostView Help - Opens the Help window 
• About - Displays the about box 

 

3.3 The Toolbar 
The toolbar is located below the menu bar and allows quick access to several menu 
items: 
 

 Opens an existing plot file. 

 Reloads the currently loaded file 

 Saves the currently loaded model 

 Saves a screenshot to file. 

 Switches to node-selection-mode. 

 Switches to element-selection-mode. 

 Zoom in on the selection 

 Zoom to the extents of the scene 

 Zoom in on a rectangular selection 

 Add a text box to the GV 

Select the current displayed expression. 

Displays the PostView Help window. 
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3.4 The Command Line 
The command line, located at the bottom right of the screen, gives the user an alternative 
way to invoke PostView commands. Most of the commands can be issued from here by 
just typing the name of the command. In addition, the command line can also be used as a 
simple calculator. 

3.4.1 Using the Command Line 
Commands can be entered on the command line by typing the command name, followed 
by the command arguments, if any. For example, the command to open a file is simply 
open, followed by the filename: 
 
>open sample.plt [enter] 
 
To repeat the last command, type an exclamation mark (!). So, for example, the following 
two commands will advance the timestep twice: 
 
>next [enter] 
>! [enter] 
 
Help for a command is also available by preceding the command name by a question 
mark (?). For example, to find out what the title command does, type: 
 
>? title [enter] 
 
Note the space between ‘?’ and ‘title’.  
Appendix A gives a detailed description of all available commands. Some commands do 
not have a menu alternative and thus can only be invoked from the command line. 
 

3.4.2 The Command Line Calculator 
The command line can evaluate simple arithmetic expressions by first typing the equal 
sign (=), followed by the expression. So, for example the following command, 
 
>= 5.2+3*(4.1–3.6) [enter] 
 
will give the result 6.7.  
The Command Line calculator recognizes the basic arithmetic operators (+, -, *, /), the 
power operator (^), floating point representation (e.g. 3.1415) as well as exponential 
representation (1.03e2), parentheses, a set of predefined named constants, 
 
pi = 3.14159265 
e  = 2.71828182 
 
and a set of arithmetic functions: 
 
cos = cosine of argument 
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sin = sine of argument 
tan = tangent of argument 
ln = natural logarithm of argument 
log = base 10 logarithm of argument 
sqrt = square root of argument 
 

3.5 The Command Bar 
The Command Bar, which is located between the time control and the command line, 
gives access to several commonly used commands. By simply clicking on the button the 
command is executed. When holding the mouse cursor over a button, a tooltip will 
appear, which gives the command that corresponds to the button. Most of these 
commands (e.g. mesh, image, title, etc.) are toggle buttons, so clicking it once deactivates 
the option and by clicking it again, the option is reactivated. 
 

 Toggle the mesh 

 Toggle the bounding box 

 Toggle the title 

 Toggle the tags 

 Toggle the triad 

 Toggle face normals 

 Toggle the legend 

 Switch between perspective and orthographic projection 

 Top view 

 Bottom view 

 Left view 

 Right view 

 Front view 

 Back view 
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Chapter 4- The Graphics View 

4.1 Elements of the GV 
The Graphics View (GV) is the area of the screen where the model is displayed. Aside 
from a 3D rendering of the model, the GV has several other components to it. The image 
below displays the GV and all of its default components. 
 

 
Figure 4. The Graphics View components 

Legend 

Triad 

Subtitle 

Title 

 
The Title component displays the title of the model. The subtitle displays additional 
information, such as selected field and current time value. The triad indicates the current 
orientation of the scene. Finally, the legend displays a colored bar and the range of the 
selected field.  
 

4.2 Customizing the GV 
The user can customize the GV by selecting and moving the different components 
around, and by adding new components. This section describes how the user can 
customize the GV. The following GV objects are currently available: 
 

• Text box: display a user-defined text 
• Triad: display the orientation of the current view 
• Legend: display a colored legend bar 
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4.2.1 Selecting and moving objects 
You can select a GV object by clicking on it with any mouse button. A selection box 
appears over the object. The object can be moved by dragging the box, while holding the 
mouse button down. If you click and drag the small triangular shaped area in the lower 
right corner of the selection box, you can resize the object. Double-clicking on an object 
brings up a properties dialog box, where you can modify the object’s properties.  
 

4.2.2 Setting the GV object’s properties 
After selecting an object, you can alter its properties by selecting Edit/Properties from the 
menu. A dialog box appears. You can also bring up this dialog box by double-clicking on 
the object. Below is an example of the properties dialog box for a text object.  
 

 
Figure 5. Text properties. 

 
The font type, font size, font color and attributes can be set in this dialog box. Note that 
not all combinations of fonts and font attributes are supported. You can also set the text 
to be displayed in the box. The text can consist of literal text and keywords. The 
keywords, which start with a percentage sign (%), will be replaced by a predefined text. 
The available keywords are listed in table 1. 
 
keyword description 
title Title of the problem. The title is set in the File/Model Info dialog box. 
field The field variable currently being displayed. 
time The time value of the current state 
state The current state number 
filename The name of the file 
filetitle The title of the file, i.e. the filename without the extension 
filepath the path of the file 

Table 1. Text box keywords 
 



 15

You can also use escape sequences, which start with a backslash (\).  
• \n: start a new line 
• \t: start the following text at the next tab position 

 

4.2.3 Adding GV objects 
PostView starts with a predefined set of GV objects. You can add new objects by clicking 
one of the GV buttons in the toolbar. Currently, PostView supports the addition of a new 
text object by clicking on the “Add text box” button.  
 

4.2.4 Deleting GV objects 
GV objects can be removed by first selecting them and then selecting Edit/Delete from 
the menu bar. Note that you cannot delete the predefined objects, namely the title, 
subtitle, legend and triad. However, you can hide these objects by selecting the 
corresponding button on the command bar. 
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Chapter 5- Post Processing 

5.1 Setting Post Viewing Options 
Most of the settings that affect the display in the Graphics View are accessed through the 
Options dialog box. This can be done by selecting the Post/Options menu, pressing the 
F2 shortcut or by typing options on the command line. Next, the Post Options dialog 
box will be displayed and looks like figure 5. 
 

 
Figure 6. The Post Options dialog 

 
The following settings can be set in the Post Options dialog box: 
 

• Show bounding box: display a box that represents the geometrical range of the 
image data. 

• Show title: display the title in the GV. 
• Show legend: display the legend in the GV. By pushing the settings button next 

to it, additional parameters that affect the way the legend is displayed can be 
selected. 

• Render smooth: if selected, uses Gouraud shading to display the plots. If not, flat 
shading is used. 

• Render outlines: render the outlines of the model. For best results, turn off the 
mesh. 
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• Surface plot: show a plot of the exterior surface of the model. The color of the 
model is based on the selected expression. Additional settings for this type of plot 
can be set by clicking the Settings button next to it. 

• Isosurface plot: shows an isosurface plot of the expression. Additional settings 
for this type of plot can be set by clicking the Settings button next to it. 

• Slice plot: shows a slice plot of the expression. Additional settings for this type of 
plot can be set by clicking the Settings button next to it. 

• Vector plot: shows a vector plot. Click on the Settings button to change the 
vector plot options. 

• Expression: affects what is being evaluated and displayed as the texture on the 
mesh. See appendix B for an overview of the available selections. 

• Color map: selects the color map that is used to color the mesh, based on the 
local values of the evaluated expression.  

• Color smoothing: If activated the colors are interpolated smoothly across the 
mesh. If not activated a discrete color map is used. 

• Element Subdivisions: select the level of element subdivision. When drawing the 
mesh in the Graphics View the elements are divided in sub-elements to improve 
the visual appearance of the mesh. Note that this has no effect on Tet-meshes 
(Tetrahedral meshes). 

• Displacement scale factor: set the displacement scale factor.  
 
Most of the options can also be set by invoking commands on the command line. See 
appendix A for a complete overview of the available commands. 
 

5.2 Summary View 
The Summary View displays an overview of minimum, maximum, and average values of 
different expressions.  This summary of values can be calculated using only selected 
elements or nodes, or for the entire selection when no elements or nodes are selected.  It 
can be opened by selecting the Post/Summary menu or by typing summary on the 
command line. Figure 7 shows the Summary View window. 
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Figure 7. Summary View 

 
To select the expression to display, click on the drop-down box in the upper left corner 
and select the desired expression. Each data point can be selected by clicking on it. The 
exact values will appear next to a selected data point. 
To save the summary data to file, click the Save button located at the bottom of the 
Summary View. This will open the File Save dialog box. After the user enters a filename, 
the data is saved to file as a simple ASCII file. The Options button shows a dialog box 
where the user can change some options.  
The graph area can be scaled or moved by click+dragging the right and left mouse button 
respectively. The buttons in the lower left corner of the Summary window can be used to 
restore the x-range, y-range or both.  
 

5.3 Trackview 
The Trackview can be used to show time history plots for individual elements or nodes. 
To display the trackview, select the Post/Trackview menu or type track on the 
command line. The Trackview should appear as in figure 8. 
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Figure 8. Trackview 

 
The Trackview displays the selected expression for the selected mesh items (see below on 
how to select mesh items). On the right, the item numbers (preceded by an ‘E’ for 
‘element’ or ‘N’ for ‘node’) are shown in the same color as the corresponding curve. The 
Clear button will clear the current selection. The Save button can be used to store the 
TrackView data to file.  
The graph area can be scaled or moved by click+dragging the right and left mouse button 
respectively. The buttons in the lower left corner of the TrackView window can be used 
to restore the x-range, y-range or both. 

5.3.1 Selecting mesh items 
You can select both elements and nodes. The item that will be selected is controlled by 
the two selection buttons in the Toolbar: 
 

 Switches to node-selection-mode. 

 Switches to element-selection-mode. 
 
To add an item to the current selection, just shift+click the node or element. When tags 
are enabled, a dot followed by the item’s number will appear next to the item. To enable 
the tags, type tags on the command line, or select the corresponding button in the 
command bar. To remove an item from the current selection, just ctrl+click the node or 
element. You can (de-) select multiple items at the same time by dragging the mouse 
cursor while holding down the shift or ctrl key and the left mouse button. A colored 
rectangle will appear indicating what elements or nodes will be selected. Note that only 
visible elements or nodes that fall inside this rectangle will be selected. This means that 
only elements or nodes on the surface of the mesh can be selected. 
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You can also use the command line to select items. For example, to select element 1000, 
type the following command on the command line: 
 
>selelem 1000 [enter] 
 
This will have the same effect as shift+clicking the element (if it is visible). However, by 
using the command line, you can also select non-visible elements.  
The command for selecting nodes is 
 
>selnode 2500 [enter] 
 
To clear the entire selection, you can either push the clear button in the Trackview dialog 
box (if it is opened) or you can use the command line by typing: 
 
>clrsel [enter] 
 
When no other windows are open (such as e.g. Trackview, etc.), pressing the ESC-key 
also clears the selection. Finally, you can select the Edit/Clear Selection menu to clear the 
entire selection too. 
 
Also note that the Edit menu lists several options to manipulate the current selection, 
such as hiding, un-hiding, inverting, etc. 
 

5.4 Making Plane Cuts 
The menu Post/Plane Cut opens the Plane Cut window. This window shows the 
intersection of a plane and the model. The intersecting plane is displayed in the Graphics 
View. The position of this plane can be controlled by sliding the scroll bar at the bottom 
of the Plane Cut window. The orientation (in x, y, z) is controlled by sliding the 
scrollbars at the top. This more accurately controls the plane normal. The roller on the 
right side of the window controls the rotation of the plane around its normal and can be 
used to position the plane cut in a more desired orientation.  
 
The color and expression used to display the plane cut are the same as in the Graphics 
View. In order to change them you need to change the expression and/or color map in the 
Post Options dialog box (see section 4.1). 
 
You can also look at local values by clicking on a specific point on the plane cut view. A 
cross mark with the local value will appear on the selected point. This is a useful way to 
inspect the local values. 
 
The Print button at the bottom of the Plane Cut window allows the user to save the 
current view to file.  
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Figure 9. The Plane cut view. Clicking the mesh allows you to inspect local values. 

 
 

5.5 The Material Manager 
The material manager controls the visual properties of the different materials in the FE 
model. It is opened by selecting Material Manager from the Post menu, typing mat on 
the command line, or by using the F3 shortcut. The Material Manager window is shown 
in figure 10. 
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Figure 10. The Material Manager handles the appearance of the different materials. 

 
The left pane displays a list of all the materials in the FE model. The colored square, 
preceding the material name, identifies the diffuse color of the material. The current 
material is highlighted with a light blue background and can be changed by clicking with 
the mouse on one of the other materials. 
The right pane shows the settings that can be altered for the selected material. The 
options are: 

• Diffuse: sets the diffuse color of the material. By clicking on the colored button, 
the Color Selector dialog is opened and the color can be changed. Closing the 
Color Selector will automatically update the color in the Graphics view. Note that 
the diffuse color is only used when no expression is selected or when the material 
is disabled. 

• Ambient: sets the ambient color for the material. Click the colored button next to 
it to change the ambient color. 

• Specular: sets the specular color for the material. Click the colored button next to 
it to change the specular color. 

• Emission: sets the emission color for the material. Click the colored button next to 
it to change the emission color. 

• Mesh Color: sets the mesh color for the material. Click the colored button next to 
it to change the mesh color. 

• Shininess: sets the shininess value for the material. Slide the slide bar to change 
the shininess value. 

• Transparency: sets the transparency value for the material. Slide the bar to change 
the transparency value. 

• Enabled: If checked the material is enabled and the color of the material is 
determined by the local expression value. If unchecked the material will be 
disabled and displayed with its diffuse color. 
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• Visible: if checked, the material will be displayed in the GV. 
• Show Mesh: if checked, the mesh lines will be drawn on top of the model. 
 
 

5.6 Displaying user data 
Besides displaying the expressions specified in the expression selector, the user can also 
display data that is imported from a file. This is achieved by using the userdata 
command. Up to five different user data files can be loaded. For example. the following 
command  
 
userdata1 "Deviatoric xy stress" dev.txt 
 
will load the data in the file dev.txt into the first user data buffer and give it a description. 
This description will show up in the expression list under the user menu and in the 
subtitle on the graphics view. 
 
The data file should be a text file with two columns, separated by a space. The first 
column contains the one-based node number. The second column contains the nodal 
value. 

5.7 The View Settings 
The View Settings dialog box (fig. 11 below) controls the settings that affect the GV. You 
can invoke it by selecting the View/Settings menu or by typing view on the command 
line. 
 
It allows you to select the following options: 

• Render style: select a style with some predefined rendering settings.  
• Background color 1: set the first background color.  (The command line 

currently supports setting color to white, black, red, green, and blue). 
• Background color 2: set the second background color.  (The command line 

currently supports setting color to white, black, red, green, and blue). 
• Swap: swaps the first and second background color. 
• Background style: set the style of the background.  The following are styles and 

corresponding commands:  Color 1=color1, Color 2=color2, Fade 
Horizontal=horz, Fade Vertical=vert, Fade Diagonally=diag. 

• Foreground color: sets the foreground color. That is the color of the title, the 
legend and the bounding box.  (The command line currently supports setting color 
to white, black, red, green, and blue). 

• Enable Lighting: Turn lighting on or off.  
• Ambient Lighting: Set the overall ambient lighting of the scene. 
• Light Position: Enter the global coordinates of the light in the scene.  
• Render shadows: Render shadows cast by the objects in the scene, using the 

current light position. (Enable Lighting must be checked). 
• Shadow Intensity: Set the shadow intensity as a number between zero and one.  



 24

 

 
Figure 11. View Settings dialog box. 

 

5.8 Saving Graphics 

5.8.1 The Safe Frame 
When storing graphics, it is important to understand the concept of the safe frame. The 
safe frame is the area of the screen that will be captured when taking a screen shot or 
recording an animation. The safe screen is not always visible, but can be displayed by 
selecting the View/Toggle Safe Frame from the menu. The same menu will hide it again.  
When visible, the safe frame can be moved and resized by selecting one of the borders 
and dragging the mouse button. To resize it, you must grab the little triangular area in the 
lower right corner of the safe frame. If you wish to specify the location and size more 
accurately, you can open the properties dialog box, by selecting the Edit/Properties menu 
or by double-clicking on one of its borders. 
 

5.8.2 Taking a snapshot 
To take a snapshot of the current Graphics View, select the File/Snapshot menu. 
Alternatively, you can press the ctrl+p shortcut or push the snapshot button on the 
toolbar. A standard Save dialog box appears and the desired filename can be entered or 
selected. Images can be saved as Windows Bitmap or TIFF images. In either case a 24 
bit, uncompressed image is saved. 
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5.8.3 Recording an animation 
PostView has the capability to record an animation of the current GV. Note that this 
feature is currently only available under Windows. To record an animation, first 
position and resize the safe frame so that it covers the desired area of the GV that will be 
captured. Next, select the Animate/New menu. This opens a standard file dialog box 
where you can enter the target filename. The file will be stored in the Windows AVI 
format. After selecting the OK button, a dialog box appears that allows you to select the 
compression type of the image. 
After you have selected a target file, you are ready for recording. Note that the safe frame 
will now be locked, so you can no longer move or resize it. If it is visible, it will turn red. 
Also note the red text in the upper right corner of the screen which indicates the current 
recording state. The recording will begin in a paused state, allowing you to make some 
changes to the GV before recording begin. 
To start recording, select Animate/Start from the menu or press the corresponding 
shortcut. Now, all the action in the GV will be recorded to the target file. For example, if 
you press the play button, the GV will loop over all timesteps and each step will be 
recorded to the file. You can also rotate the GV and this will also be recorded to the file. 
To pause the recording, select Animate/Pause from the menu. To finally stop the 
recording, select Animate/Stop from the menu. This will close the target file and unlock 
the safe frame. 
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APPENDIX A – Commands 
Here follows a list of all the commands recognized by PostView. A command can have 
no arguments, optional arguments or mandatory arguments. The general syntax is: 
 
command [optional arg] <mandatory arg> [option A |option B], 
 
where command is the name of the command, [a] indicates optional arguments, <a> 
indicates mandatory arguments, [ a | b ] indicates a list of choices. 
 
! repeats the last command 
? <command> provides help on a command, where command is the name of the 
command. 
= <expression> invokes the command line calculator. 

FILE COMMANDS 
exit Exits the application. 
info Displays information about the current model and plot file. 
open [filename] If filename is present, opens the file, otherwise opens the 

File Open dialog box. 
print [filename] Prints the current view to a file with name filename. If 

filename is omitted, the File Save dialog is opened. 

POST/IMAGE COMMANDS 
box [on|off] Shows (on) or hides (off) the bounding box in the Graphics 

View. 
color <colormap>  Sets the color map. Refer to section 4.1 for valid colormap 

commands. 
cut Displays the plane cut view. 
range [static|dynamic|user <min max>] Sets the range for the legend. 
legend [on|off] Shows (on) or hides (off) the legend in the Graphics View. 
mat Shows the material manager. 
mesh [on|off] Shows (on) or hides (off) the mesh. 
options Displays the post-options dialog box. 
smooth [on|off] Renders the model in smooth (on) or flat (off) shade. 
summary Displays the post-summary. 
title [on|off] Shows (on) or hides (off) the title in the Graphics View. 
track Displays the track view 
triad [on|off] Shows (on) or hides (off) the triad. 
userdata(n) <"description"> [filename] Loads user data from file. 

TIME CONTROL COMMANDS 
anim [fps] Starts the animation, with optional framerate fps 
first Go to the first time step. 
last Go to the last time step. 
next Go to the next time step. 
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prev Go to the previous time step. 
stop Stop the animation 
time <time> Go to time timestep, where time is a number between 1 

and the max numbers of timesteps. 

FIELD SELECT COMMANDS 
eval <expression> Evaluates the expression. Refer to Appendix B for valid 

expression commands. 

EDIT/SELECTION COMMANDS 
clrsel Clears the selection. 
hide Hides the current selection. 
selelem <elem id> Selects element with element id elem id. 
selnode <node id> Selects node with node id node id. 
tags [on|off] Shows (on) or hides (off) the selected item's tags. 

 

TRANSFORM COMMANDS 
back  Display back view. 
bottom Display bottom view. 
front  Display front view. 
left Display left view. 
right Display right view. 
pan <x> <y> Sets the panning coordinates (x, y) 
quat <x> <y> <z> <w>  Sets the orientation quaternion q(x,y,z,w) 
rotx <angle> Rotate angle degrees around the x-axis. 
roty <angle> Rotate angle degrees around the y-axis. 
rotz <angle> Rotate angle degrees around the z-axis. 
top Display top view. 
zoom <z> Sets the zooming coordinate (z) 

VIEW COMMANDS 
bg [color name| r g b] Set background color 1 either by name or RGB value (0-1).
bg1 [color name| r g b] Set background color 1 either by name or RGB value (0-1).
bg2 [color name| r g b] Set background 2 color either by name or RGB value (0-1).
bgstyle <style> Set the background fading style.  Refer to section 4.7 for 

valid style commands. 
fg [color name| r g b] Set foreground color either by name or RGB value (0-1). 
view Options the view settings dialog box. 

HELP COMMANDS 
about Displays the about box. 
help Displays the PostView help window. 
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APPENDIX B – Expressions 
 
Expression Field Description Command

Displacement:     
X displacement Displays displacement in the x direction xdispl 
Y displacement Displays displacement in the y direction ydispl 
Z displacement Displays displacement in the z direction zdispl 
XY displacement Displays displacement as the xy shear  xydispl 
YZ displacement Displays displacement as the yz shear  yzdispl 
XZ displacement Displays displacement as the xz shear  xzdispl 
Total displacement Displays total displacement displ 
Velocity:     
X velocity Displays x component of velocity xvel 
Y velocity Displays y component of velocity yvel 
Z velocity Displays z component of velocity zvel 
XY velocity Displays xy component of velocity xyvel 
YZ velocity Displays yz component of velocity yzvel 
XZ velocity Displays xz component of velocity xzvel 
Total velocity Displays total velocity vel 
Acceleration:     
X acceleration Displays x component of acceleration xacc 
Y acceleration Displays y component of acceleration yacc 
Z acceleration Displays z component of acceleration zacc 
XY acceleration Displays xy component of acceleration xyacc 
YZ acceleration Displays yz component of acceleration yzacc 
XZ acceleration Displays xz component of acceleration xzacc 
Total acceleration Displays total acceleration acc 
Strain:     
X strain Displays strain in the x direction xstrain 
Y strain Displays strain in the y direction ystrain 
Z strain Displays strain in the z direction zstrain 
XY strain Displays strain as the xy shear  xystrain 
YZ strain Displays strain as the yz shear  yzstrain 
XZ strain Displays strain as the xz shear  xzstrain 
Effective strain Displays effective stain  vmstrain 
Principle strain 1 Displays first principle strain component e1 
Principle strain 2 Displays second principle strain component e2 
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Principle strain 3 Displays third principle strain component e3 
Prin dev strain 1 Displays first principle deviatoric strain component e1dev 
Prin dev strain 2 Displays second principle deviatoric strain component e2dev 
Prin dev strain 3 Displays third principle deviatoric strain component e3dev 
Max shear strain Displays texture strain as the maximum shear maxe 
Plastic strain Displays texture strain of plastic plast 
Stress:     
X stress Displays stress in the x direction xstress 
Y stress Displays stress in the y direction ystress 
Z stress Displays stress in the z direction zstress 
XY stress Displays stress as the xy shear  xystress 
YZ stress Displays stress as the yz shear  yzstress 
XZ stress Displays stress as the xz shear  xzsress 
Von Mises stress Displays as a Von Mises stress  vmstress 
Principle stress 1 Displays first principle stress component s1 
Principle stress 2 Displays second principle stress component s2 
Principle stress 3 Displays third principle stress component s3 
Prin dev stress 1 Displays first principle deviatoric stress component s1ev 
Prin dev stress 2 Displays second principle deviatoric stress component s2dev 
Prin dev stress 3 Displays third principle deviatoric stress component s3dev 
Max shear stress Displays stress as the maximum shear maxs 
Pressure stress Displays stress resulting from pressure press 
Other:     
Temperature Displays temperature temp 
Shell Thickness displays the shell thickness sthick 
Volume Ratio displays volume ratio (=V/V0=det(F)) J 
Quality:     
volume displays the element volume vol 
max edge angle displays the max element edge angle maxedge 
min edge angle displays the min element edge angle minedge 
aspect ratio displays the element aspect ratio ar 
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